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About Metadata

By simple definition, metadata is data about data. Metadata is structured information
that explains, describes, or gives the location of the primary data, or that otherwise
makes using the primary data more efficient. A wide variety of industries use metadata,
but for the purposes of digital imaging, there are currently only a few technical structures
or schema in use. A schema is a set of properties and their defined meanings, such as
the type of value (for example, date, size, or URL).

File Info

Prior to Adobe® Photoshop® CS2 software, the primary image metadata schema was
File Info, which is nonimage data embedded in image files. Originally deployed by
the International Press and Telecommunications Council (IPTC), this metadata
contains only a few fields of limited text that is used to help organize and distribute
photographic images for newspaper publishing. File Info, which is the Photoshop
implementation of the IPTC specification plus additional data fields, defines both the
storage format and the actual metadata. Text fields in the current specification include,
but are not limited to, Caption, Caption Writer, Headline, Special Instructions,
Keywords, Category, Supplemental Categories, Urgency, Byline, Byline Title, Credit,
Source, Object Name, Date Created, City, Province-State, Country Name, Original
Transmission Reference, and Preserve Additional Information. Mark As Copyrighted
and URL are additional fields beyond the IPTC specification. Photoshop CS2 and
Adobe Bridge incorporate the new IPTC for XMP specification in addition to legacy
IPTC metadata.

The IPTC fields allow only a relatively small amount of text information to be embedded
within the file, but it is critical that this information moves through publishing systems
locked together with the file. This embedded information is critical for the thousands
of digital images used in major newspaper companies. Surprisingly, a large number of
Photoshop users don’t realize that these metadata fields exist. Photographers routinely
send out digital images without even marking them as Copyrighted or embedding
simple ownership or contact information.

EXIF

Several years ago, a group of major photographic manufacturers, in conjunction with the
Japan Electronic and Information Industries Association (JEITA), developed a metadata
schema called Exchangeable Image File Format (EXIF). This schema is designed to embed
in a digital capture—right at the moment of exposure—information relating to the
camera’s function and image parameters, and additional miscellaneous information.

Unfortunately, the various schemas currently used in image file metadata do not yet meet
the explicit needs and desires of imaging artists and photographers. For EXIF or any
additional schema to reach broad adoption and acceptance, the creators of digital images
must be brought into the process of designing and specifying metadata implementations.
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XMP framework

At Seybold San Francisco in the fall of 2001, Adobe Systems Incorporated announced a new
technology initiative called Extensible Metadata Platform (XMP). XMP is a common metadata
framework that standardizes the creation, processing, and interchange of document metadata
across publishing workflows. Adobe has also committed to the World Wide Web Consortium
(W3C) standards, including Extensible Markup Language (XML). Thus, XMP is XML-compatible.
For the future of metadata and its usefulness to photographers and imaging artists, XMP holds
the promise of providing a significant and extensive platform for a wide array of various metadata
implementations. Both public and private metadata schemas can use a widely adopted framework
schema that will enable a rich and extensive use of metadata for critical technologies, such as
Digital Rights Management (DRM) and Digital Asset Management (DAM).

Adobe Creative Suite 2, which includes Adobe Photoshop, Adobe Illustrator®, Adobe InDesign®,
Adobe Acrobat®, and Adobe Bridge, has achieved broad support for XMP across most Adobe
applications. Photoshop CS2 and Bridge in particular offer an extensive deployment of XMP.

Present and future possibilities of metadata

Because of the lack of coordination between manufacturers and organizing bodies, much of the
potential of metadata remains unrecognized. Following are examples of metadata and how it can
help photographers, both now and in the future.

You can use the File Info dialog box to view and append or replace metadata in image files.

VB7J9512.DNG 'VB7J9983.DNG
| — v - » |
Descrpton ® Descripton e
Camera Data 1 Camera Data 1
Camera Data 2 Document Title: ] Camera Data 2 Document Title: Iceberg in Antarctica |
Categories . Bl Categories . - &l
Histary Author: Histary Author:  Copyrighted by Jeff Schewe
IPTC Contact Authior Title: ] IPTC Contact Author Title: Photagrapher (|
IPTC Content o IPTC Content -
IPTC Description: ] PTC Description: Iceberg shot in Antarctica in Cierva Cove during a Zodiac cruise. ]
Image IPTC Image Approximate latitude and longitude: 64°090'S 61°07'W
IPTC Status IPTC Status
Adobe Stock Photos Adobe Stock Photos
Origin Description Writer: | Origin Description Writer: Jeff Schewe |
Advanced Keywords: | dvniced Keywords: Antarctica; Antarctic peninsula; iceberg; zodiac cruise: Cierva Cove; ]
Landscape
| Commas can be used to separate keywords ! Commas can be used to separate keywords |
Copyright Status: | Unknown ) Copyright Status: | Copyrighted 3}
Copyright Notice: ] Copyright Notice: ©2005 by Jeff Schewe i
ALL RIGHTS RESERVED
Copyright Info URL: ol Copyright Info URL: Thttp:/ jwww.schewephoto.com i}
GoTo URL..._ Go To URL..
Created: 12/6/05 10:09:52 AM Created: 12/6/05 10:09:52 AM
Modified: 12/6/05 10:09:52 AM Modified: 12/6/05 4:50:03 PM
Powered By Application: Powered By Application:
Xxmp Format: image/tiff Xmp Format: image/tiff
T i )

The basic File Info dialog box in Photoshop CS2 (left) and the fields entered with metadata (right)

Embedded metadata can be in XMP form and is also aliased to other schemas for backward com-
patibility. Some of the information, such as the IPTC metadata, is editable; other information is
read-only. The creator of an image file should adopt a policy regarding whether subsequent users
should replace or simply append existing metadata. For example, it would be inappropriate for
users who didn’t create the image file to remove or replace the Author information or change an
image marked Copyrighted to Unknown.
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You can view a variety of metadata for any file in the File Info dialog box, including IPTC, EXIF,

Camera Raw settings (for raw files), and more. You can even view the saved edit history of an
image if you use the history tracking feature in Photoshop CS2, and the history is embedded in

the file as metadata.

VB7)9512.DNG

VB7)9512.DNG

' Description || CameraData 1 ®
| Camera Data 2 Make:SGarion
Categories Meodel: Canon EQS-1Ds Mark Il
Blstory Date Time: 2005-12-06T10:09:52-06:00
IPTC Contact
IPTC Content Shutter Speed: 1/1600 sec
IPTC Image Exposure Program: Aperture priarity
IPTC Status
Adobe Stock Photos F-stop: /6.3
Origin Aperture Value: f/6.3
Advanced
Max Aperture Value: f/5.0
ISO Speed Ratings: 100
Focal Length: 100.0 mm
Lens: 70.0-300.0 mm
Flash: Did not fire

No strabe return detection (0)

Compulsory flash suppression (2)

Flash function present

No red-eye reduction

Metering Mode: Pattern
Powered By
Xmp
o) G

Description
Camera Data 1
Camera Data 2
Categories

History

| IPTC Contact

| IPTC Content

IPTC Image

IPTC Status

Adobe Stock Photos
Origin

|

Advanced

®

¥ http://ns.adobe.com/camera-raw-settings/1.0/

crs:Version: 3.3x43
crs:RawFileName: VB7]9512.DNG
crs:WhiteBalance: Custom
crs:Temperature: 5400
crs:Tint: +4
crs:AutoExposure: True
crs:Exposure: +0.65
crs:AutoShadows: True
crs:Shadows: 13
crs:Brightness: 38
crs:Contrast: +78
crs:Saturation: 0
crs:Sharpness: 25
crs:LuminanceSmoothing: 0
crs:ColorNoiseReduction: 25
crs:ChromaticAberrationR: 0
crs:ChromaticAberrationB: 0
crs:VignetteAmount: 0
crs:ShadowTint: 0
crs:RedHue: 0
crs:RedSaturation: 0
crs:GreenHue: 0
crs:GreenSaturation: 0
crs:BlueHue: 0
crs:BlueSaturation: 0

( Replace.. ) (_ Append.. ) ( Save..

D

——————————————

Delete

Some of the EXIF metadata fields (left) and the recorded Camera Raw settings (right).

Some metadata is known as public data and some of it is referred to as private data. While there
are standards for all public metadata fields, the private fields are largely undocumented. That is
one of the problems associated with some of the private maker notes embedded in proprietary

raw digital camera files.

IPTC Contact
IPTC Content
IPTC Image
IPTC Status

New to Photoshop CS2 and Adobe Bridge is the addition of IPTC Core, four custom metadata fields that conform

to the new IPTC for XMP.
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VB79512.DNG

VB7)9512.DNG

| Description IPTC Contact @ Description IPTC Content ®
Camera Data 1 Camera Data 1
Camera Data 2 Use this panel to record the photographer’s contact information. e Dt Use this panel to describe the visual content of the image.
Categories Creator [Copyrighted by Jeff Schewe c Catagoeics Head! o
| History History
IPTC Contact Creator's Job Title |Photographer H IPTC Contact
| IPTC Content | IPTC Content
e Address 624 West Willow St. ) Description lceberg shot in Antarctica in Cierva Cove during a Zodiac cruise ®
| mAge. mage Approximate latitude and longitude: §4°090°S 61°07'W
| IPTC Status IPTC Status
| Adobe Stock Photos Adobe Stock Photos
| Origin Gity [Chicago Origin
| Advanced St e = Ad
tate/Province ||linois Keywords* /Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove ]
‘ Postal Code [gog14
Country [Usa
- IPTC Subject Code* i}
Phone(s)
|
| e Subject codes are defined at hitp://www.newscodes.org
| Description Writer joff Schewe =
Website(s) http://www.schewephoto.com
L L] J * Multiple values may be separated by a comma or semicolon.
Metadata templates can populate multiple fields at once.
= By Access metadata templates frem the upper right corner of this dialog. B By
Xm p‘ Support and updates for these IPTC panels can be found at hitp:{ /www.iptc.orgfiptcdxmp Xim p-
¢ oo )
VB7J9512.DNG VB7J9512.DNG
[ Description IPTC Image (C} Description IPTC Status C}
Camera Data 1 Camera Data 1
Camera Data 2 Use this panel for formal descriptive information about the image. Camera Data 2 Use this panel to record workflow and copyright information.
Categories Date Created 126,05 T} Categories Title ceberg in Antarctica ]
History History
IPTC Contact Intellectual Genre IPTC Contact Job Identifier i}
| IPTC Content |PTC Scene* IPTC Content etoictions )
IPTC Image IPTC Image
| IPTC Status | IPTC Status
Adaobe Stock Photos Adobe Stock Photos
Origin Scene values are defined at htp:/ fwww.newscodes.org Origin
: Advanced Advanced Provider o
Location Antarctica [}
| Source i
City |
Copyright Notice ©2005 by Jeff Schewe i
State/Province [+ ALL RIGHTS RESERVED
Country Antarctica ]
150 Country Code .
| Rights Usage Terms ALLRIGHTS RESERVED, no reproduction in any form is authorized without | [+l
Country codes may be either 2- or 3-letter codes as defined by the ISO 3166 standard. the express written consent of Jeff Schewe
* Multiple values may be separated by a comma or semicolon.
Powered By Powered By
xXmD Xmy

Conei ) G0

el ) G0

IPTC Core has new fields for use

with digital images.
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Embedding metadata image by image isn’t particularly productive. While IPTC metadata can be
embedded using Actions and Batching operations in Photoshop, it’s useful and more productive
to use Adobe Bridge to add metadata to multiple files at once.

aa6 Antarctica-card - Adobe Bridge
w4 hi Antarctica-card E = ot SRR
Folders ®

= "IVolumes/MAIN-ARRAY, Antarctica-card/

Metadata 0]

Filename t VB7]977E.DNG
Document Kind * Camera Raw

Date Created t 12/6/05, 11:40:26 AM
Date File Created * 1/18/06, £:53:02 PM
Date File Modified ! Today, 2:17:21 PM

File Size: 1 11.46MB

Dimensions 1 4992 x 3328
Resalution ! 240 dpi

Bit Depth t 16

Creator
Creator: job Title
Creator: Address :
Creator: City i
Creator: State/Province
Creator: Postal Code
Creator: Country
Creatar: Phone(s)
Creatar: Email(s) :
Creatar: Websitels) !
Headline :
Description

IFTC Subject Code
Description Writer
Date Created
Intellectual Genre
IPTC Scene
Location

City :
State/Province :
Country .
IS0 Country Code 3
Title :
Job identifier
Instructions :
Provider :
Source :

VB7)..DNG S

Blerreretrhehihorhbhhhbhbiohhhiots

4F 47 items, 14 hidden, 1 selected

Image selected in Adobe Bridge

In the File Browser, there are movable panes that contain the fields of metadata that you have
chosen to show. You can control which fields are visible by choosing them from the Metadata
Display Options in the Edit menu of the File Browser.

Preferences

Conersl | Metadaa
Metadata

Labels Filename
File Type Associations Preserved Filename
Advanced Document Kind

Adobe Stock Photos Application

Date Created
Date File Created
Date File Modified
File Size
Dimensions
Resolution
Bit Depth
Color Mode
Color Profile
Label

Rating
Notes

8 [ S SRS ER RN RN S ESIEN N

Creator

Creator: Job Title
Creator: Address
Creator: City
Creator: State/Province
L=

Powered By ™ Hide Empty Fields

Xinip )

< r i

Select fields you wish to see in the Metadata preferences in Adobe Bridge.
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Filename © VB7J9545.DNG Creator & 1/1000s at /8 Raw Filename : VB7)3545.DNG
Preserved Filename 3 : Creatar: Job Title & Expasure Bias Value 1 -0.33 L White Balance ! Custom
Document Kind ! Camera Raw Creator: Address P Exposure Mode Auta | Temperature L 5400°K
Application 2 Creatar: City & Expasure Index : | Tint =T

Date Created © 12/6/05, 10:44:16 AM Creator: State Province Fig Exposure Program Aperture priority | Exposure L +1.10
Date File Created t 1/18/086, i Creator: Postal Code & Brightness Value : L Shadows 30

Date File Modified * 1/19/08, Creator: Country F ISO Speed Ratings 100 Brightness 19

File Size {1122 MB Creator: Phonels) & Focal Length P70 mm Contrast L +BS
Dimensions ' 4992 x 3328 Creatar: Email(sh & Focal Length in 35mm Film : Saturation 45
Resolution 240 dpi Creator: Website(s) & Lens : 70.0-300.0 mm | Sharpness 125

Bit Depth 16 Headline F Max Aperture Value f14.6 | Luminance Smoothing D

Color Mode RGEB Color Description +# Software : ‘ Color Noise Reduction 25
Calor Profile * ProPhoto RGE Keywords EXIF Copyright ‘2005 by Jeff Schewe Chromatic Aberration R/C © 0

e . : e RieaEaE @ )  ALLRIGHTS RESERVED Chromatic Aberration B/Y : D

Rating || | Description writer &£ LIt : L Vignette Amount ‘o

i o | |ipate cramsd # 1| | DateTime 12/6/05, 10:44:16 AM 'a| | vignette Midpoint i

Supports XMP Yes B | nellectuial Gerire # w| | DateTime Original © 12/6/05, 10:44:16 AM E Shadow Tint 10

Selected fields appear as a scrollable list in the Metadata panel in Adobe Bridge.

You can edit metadata directly in the fields that allow editing (such as IPTC) either image by

image or in selected groups. However, it’s more productive if you create and save custom meta-

data templates.

086
& » 12 Al

7 Flle Properties
Filename
Document Kind |
Date Created

Date File Created |
Date File Modified
File Size |
Dimensions
Resolution |
Bit Depth
VIFTCCore |
Creator

Creatar: Job Title |
Creator: Address
Creator: City |
Creator: State/Provi
Creator: Postal Cod{
Creator; Country
Creator: Phone(s) |
Creator: Email(s)
Creator: Website(s) |
Headline
Description |
IPTC Subject Code
Description Writer |
Date Created
Intellectual Genre |
IPTC Scene

Location |
City

State/Province |
Country

IS0 Country Code |
Title

Job Identifier |
Instructions

Antarctica-card - Adobe Bridge
Camera Data 1
Camera Data 2 Document Title: Iceberg in Antarctica |
Categories :
Author: i T
History or: Copyrighted by Jeff Schewe
IPTC Contact Author Title: 'Fhotographer i
IPTC Content —
PTC Description: Iceberg shot in Antarctica in Cierva Cove during a Zodiac cruise. ]
mage Approximate |atitude and longitude: 64°090'S 61°07'W
IPTC Status
Adobe Stock Photos
Origin Description Writer: | Jeff Schewe |
Advanced Keywords: Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove ]
| Commas can be used to separate keywords
Copyright Status:  Copyrighted @
Copyright Notice: ©2005 by Jeff Schewe [
ALL RICHTS RESERVED
Copyright Info URL: http:/ /www.schewephoto.com |
Go To UR!
|8
Created:
Modified: 12/6/05 11:40:26 AM
Powerad By Application:
XI HH p' Format:

Provider
Source

{r 47 tems; 14 hidden, 1 selected

( Cancel )M

The figure above shows the File Info dialog in Adobe Bridge. You can fill it out manually as I've done here and then
save it out as a metadata template to apply to multiple images.
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To create a custom template, first select an image in the File Info dialog box. Then choose File >
File Info and fill in the fields that can be applied to a wide variety of the images you’ll be working
on, such as Copyright Status, Author, and Copyright Notice. Choose Save Metadata Template
from the pop-up menu, and then close the dialog box. You can name the template in the Save
dialog box that appears. The template will then be saved and will appear in the pop-up menu of
the File Info dialog box and also in the File Browser.

T scHewe-2005 Save Metadata Template

Save Metadata Template... |. Template Name: Antactica-Cierva Cove
Delete Metadata Template... :

Cancel )  Save )
Show Templates... ( SHER )

Saving a custom metadata template (left) with a descriptive name (right)

Bridge File Edit IEE Label View Window Help

Batch Rename... {r38R
Version Cue
Photoshop Services

Photoshop
Illustrator
InDesign

v vyvwvyw v v

Cache
Import from Camera... L
Append Metadata > Antarctica-Cierva Cove .
] Replace Metadata > SCHEWE-2005

A saved template appears in the Edit menu of Adobe Bridge.

After you select the template, you’ll be alerted that you are applying metadata to multiple
selected files. Choose Don’t Show Again if you don’t want to see the alert the next time you
apply the template.

Adobe Bridge
You have selected multiple files. When you
' apply your edits, all files in the selection will be
L affected. Do you want to continue?

Bridge returns an alert when you apply a metadata template to multiple files.

If you are adding metadata to raw files, note that the data will be stored only in separate sidecar
files in the same folder as the file or in the Camera Raw database, depending on your preferences.
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Camera Raw and Photoshop CS2 embed the metadata directly in the processed file when it is
saved. Note also that all public metadata fields will also be in the file, including EXIF, Camera
Raw settings, and image history (if you selected that option).

606 metadata-screens - Adobe Bridge
B & Unfikered ~ B 0 & | & | &

[IVolumes [MAIN-ARRAY [ Antarctica-card/

L3 Antarctica-card

Folders

! Copyrighted by Jeff Schewe &
Creator: Job Title : Photographer &
Creator: Address * B24 West Willow 5t. &
Creator: City : Chicago &
Creator: State/Province  * lllinois &
Creator: Postal Code : B0A14 &
Creator: Country - Usa &
Creator: Phonels) & & VB7)..DNG =&
Creator: Email(s} * info@schewephoto.com @
Creator; Website(s) http:ff &

www.schewephoto.com

Headline : Fd
Description ! leeberg shot in Antarctica in &%

Cierva Cove during a Zodiac
cruise. Approximate
latitude and longitude:
B47000'S B107W L e e e R DRSS e e

Renaids  Pultipie val <) | vez.ong & @ | ez .DNG HE | ver.oNG & B | ve79sTaONG & VE7)..DNG &8
IPTC Subject Code :

Description Writer * Jeff Schewe

Date Created :

Intellectual Genre

IPTC Scene

Location  Antarctica

City :

State/Province :

Country * Antarctica

IS0 Country Cade £

Title t Iceberg in Antarctica
Jeb Identifier :

Instructions

Provider

Source

Copyright Notice 1 ©B2005 by Jeff Schewe
ALL RICHTS RESERVED

Rights Usage Terms - All Rights Resered-no
repreduction of any kind . e
withaut express written |48 vemesszone & | vezssszonc & | verioong S@ | venoone S8
persmission from Jeff i

VE7/9501.0NC & VB7I9002.0NC & VET)I026.0NG & VE7)..DNG B8

B YR RRhhhhYhhRRYRRRwYR

4F 47 items, 14 hidden, 47 selected

Embedded metadata in selected files

After you apply the template, all of the images will have updated metadata from the template.
You can still edit individual fields (for example, adding keywords) on an image-by-image basis.

©00 %16 V87/9983.0NG @ 33.3% (RG8/8°) ) VB7J9512.DNG
| Description LI ®
Camera Data 1
Camera Data 2 Document Title: [ceberg in Antarctica ]
Categories
Author: ? ]
e uthor: [Copyrighted by Jeff Schewe
IPTC Contact Author Title: Photographer o
IPTC Content .
e Description: iceberg shot in Antarctica in Clerva Cove during a Zodiac cruise. ]
mAge Approximate |atitude and longitude: 64°090°S 61°07'W
IPTC Status
Adobe Stock Photos
Origin Description Writer: |Jeff Schewe ]
Advanced Keywords: Antarctica; Antarctic peninsula; iceberg; zodiac cruise; Cierva Cove ’ |
| Commas can be used to separate keywords
Copyright Status: | Copyrighted #
Copyright Notice: ©2005 by Jeff Schewe ]
ALL RIGHTS RESERVED
Copyright Info URL: Thttp: //www.schewephoto.com i}
Go To URL...
Created: 12/6/05 10:09:52 AM
Modified: 12/6/05 10:09:52 AM
PoweredBy Application:
Xmp Format: image/tiff
o

This processed raw file (left) has had the common metadata (right) entered and saved as part of the raw processing.
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Conclusion

Metadata has phenomenal potential for the photography industry. For example, sup-
pose two photographers are on assignment and shoot from the identical position with
identical lighting. For all practical purposes, the images would be identical, and you
would be unable to differentiate who shot which image. By using metadata, you would be
able to see the serial number of the camera body and the owner’s copyright, providing
conclusive proof of ownership.

By using metadata to embed keywords in the images you intend to place in stock librar-
ies, you can reduce or elimate the large amounts of time and money currently spent
adding keywords. The current cost of placing a film-based image into a stock library
and duplicating it can be as high as $140.00 per image. Reducing the amount of time
that an agency spends applying keywords, along with solving other image identification
problems, could drastically reduce the actual cost of placement within a system. Adding
rich keywords and additional information actually makes an image more valuable.

Photographers and imaging artists can take advantage of metadata for many aspects
of their imaging businesses. They can incorporate licensing information for an image,
along with the password security for opening the file, into a metadata schema. Imagine
being able to embed a unique image identification that will travel wherever the image
goes—Photoshop CS2 does that right now. Users could generate and complete invoices
and transactions by using metadata or billable time while image processing, or to track
exactly what was done to an image file, and when.

Additional resources about metadata

Adobe XMP
www.adobe.com/products/xmp/main.html

Dublin Core Metadata Initiative
www.dublincore.org

Japan Electronic and Information Industries Association (EXIF)

www.jeita.or.jp/

International Press Telecommunications Council (IPTC)
www.iptc.org

IPTC for XMP
www.iptc.org/IPTC4XMP

World Wide Web Consortium (XML)
www.w3.0rg
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